LX 500
COLOR LABEL PRINTER
LX 500c
COLOR LABEL PRINTER
RX 500
COLOR RFID PRINTER

User's Manual

© 2019 All rights reserved
Notices: The information in this document is subject to change without notice. NO WARRANTY OF ANY KIND IS MADE WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. No liability is assumed for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material. This document contains proprietary information that is protected by copyright. All rights are reserved. No part of this document may be photocopied, reproduced, or translated into another language without prior written consent.

Trademark Acknowledgments: Windows is a registered trademark of Microsoft Corporation. All other trademarks are the property of their respective owners.

Printing History
Edition 1.0, #032719, Copyright 2019 All rights reserved.

FCC Compliance Statement: This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

For Users in the United States: This product is intended to be supplied by a UL listed Direct Plug-In Power Supply marked "Class 2" or a UL listed ITE Power Supply marked "LPS" with output rated 12VDC, 4.5A or higher. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re-orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Use of shielded cables is required to comply with the Class B limits of Part 15 of the FCC Rules. You are cautioned that any changes or modifications not expressly approved in this manual could void your authority to operate and/or obtain warranty service for this equipment.

For Users in Canada: This digital apparatus does not exceed the Class B limits for radio noise for digital apparatus set out on the Radio Interference Regulations of the Canadian Department of Communications. Le present appareil numerique n’emet pas de bruits radioelectriques depassant les limites applicables aux appareils numeriques de la class A prescrites dans le Reglement sur le brouillage radioelectrique edicte par le ministere des Communications du Canada.

CAUTION!
TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THE UNIT TO RAIN OR MOISTURE. TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE EXTERIOR PANELS. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL. OPERATE THE UNIT WITH ONLY THE PROPER ELECTRICAL SPECIFICATIONS AS LABELED ON THE PRINTER AND AC ADAPTER.

CAUTION!
THIS PRODUCT CONTAINS A LASER DIODE OF A HIGHER CLASS THAN 1. TO ENSURE CONTINUED SAFETY, DO NOT REMOVE ANY COVERS OR ATTEMPT TO GAIN ACCESS TO THE INSIDE OF THIS PRODUCT. REFER ALL SERVICING TO QUALIFIED PERSONNEL. THE FOLLOWING LABEL APPEARS INSIDE YOUR UNIT:
CLASS 1 LASER PRODUCT LASER KLASSE 1

CAUTION!
USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN MAY RESULT IN HAZARDOUS RADIATION.
There are interactive features that allow you to jump to different locations within the document. Each listing in the Table of Contents is interactive. Place the cursor on either the words or the page number. A small hand with a pointing finger icon appears. Click on the line with the icon and the document will jump to that page. If you want to return to the Table of Contents, move the icon to the top of the page and click on the arrow marked TOC. Navigating to the Index (if there is one) is similar. Place the icon on one of the listings or page numbers, click on it, and it will move to that page. Returning to the Index can be done by clicking on the arrow marked Index.
Table of Contents

Section 1: Getting Started ................................................................. 1
   A. Choosing a Good Location ................................................. 1
   B. Unpacking and Inspection .............................................. 2
   C. Identifying the Parts ..................................................... 3

Section 2: Hardware and Software Setup ....................................... 5
   A. Installing Label Stock ..................................................... 5
   B. Adjusting the Stock Gap Sensor Position ....................... 7
   C. Using Fan-fold Label Stock ........................................... 10
   D. Installing the Ink Cartridge .......................................... 10
   E. Aligning the Ink Cartridge ........................................... 13

Section 3: Primera PrintHub ........................................................... 14
   A. Monitoring Ink Levels ..................................................... 15
   B. Using the Cost Estimator .............................................. 16
   C. Set the Stock Sensor Mode ............................................ 17
   D. Set the Present or Cut Mode (Cutter Models Only) .......... 18
   E. Adjusting Print Alignment ............................................ 21
   F. Settings .......................................................................... 22

Section 4: Using RFID (PC Only) .................................................. 26
   A. Setup RFID ...................................................................... 26
   B. Printing and Encoding .................................................... 27
   C. Tag Specifications .......................................................... 28

Section 5: Printing Using a PC ....................................................... 30
   A. Using BarTender® .......................................................... 30
   B. Add Text, Barcodes and Graphics to BarTender Label .... 34
   C. Printing from BarTender® ............................................. 35
   D. Printer Driver Settings (PC) ........................................... 36
   E. Printing from other Programs ........................................ 39

Section 6: Printing from a Mac ...................................................... 41
   A. Printer Utility Settings (Color Label 500 Utility) ............... 41
   B. Adjusting Print Alignment / Label Offsets ...................... 43
   C. Set the Stock Sensor Mode ............................................ 45
   D. Set the Output Mode .................................................... 46
THANK YOU...

...for choosing an LX500/LX500c/RX500 Color Label Printer. The LX500 Printer will print razor-sharp text and barcodes, vibrant colors, and even stunning photo-realistic photographs directly onto rolls of labels, card stock and fan-fold stock. The LX500c adds an integrated cutter to cut between each label. The RX500 adds the ability to encode to label stock with integrated RFID chips. It has has a built in cutter.

This User's Manual is your complete step-by-step guide to quickly and easily setting up and printing with your new Color Label Printer!

A. CHOOSING A GOOD LOCATION

- Place the printer on a flat surface in a location with adequate air circulation to prevent internal heat build up.
- Do not place the printer near heat sources such as radiators or air ducts, or in a place subject to direct sunlight, excessive dust, mechanical vibration or shock.
- Allow for adequate clearance in front of the printer to accommodate the printed label stock as it is leaving the printer to avoid the possibility of binding or jamming of the label stock.
- Allow for adequate overhead clearance for opening the top cover to allow easy access to the label stock and ink cartridge.
B. UNPACKING AND INSPECTION

While unpacking your printer, inspect the carton to ensure that no damage has occurred during shipping. Make sure that all supplied accessories are included with your unit. The following items should be included:

- Printer
- Power Adapter
- Separate Power Cord
- 6’ USB Cable (If other USB cable is used, it must be 6’ (2 M) or less.)
- Color Ink Cartridge
- Starter roll of high gloss label stock
- Warranty Statement and Registration Card
- This manual and other printed information

Save the carton and packing materials. They will come in handy when transporting the printer.
This illustration shows the front of the printer with its control buttons and LED indicator lights.

The **Ink Low LED** will illuminate when a cartridge has 10% or less of its ink remaining.

The **Power LED** indicates that the printer is on and ready to receive print jobs.

The **Ink Button** moves the carriage to the center to allow for loading of the ink cartridge. Once the cartridge is loaded, press the ink button again.

The **Load/Feed Button** is pressed in order to load label stock or form feed the label stock through the printer.

The **Unload Button** will unload the installed label stock by reversing it through the printer. Make sure to tear off the printed labels before pressing the Unload Button.

The **Label Tear Bar** is a serrated edge for conveniently tearing your finished labels from the printer.
This illustration shows the input ports and power switch found on the rear panel of the printer.
A. INSTALLING LABEL STOCK

Your printer will utilize a wide variety of paper label stock. As long as the label stock is paper and can receive ink jet printing and is within the allotted size, it will work in the printer. Primera carries a large variety of paper label stock that has been converted and ready for use with your printer.

1. Open the Top Cover.
2. Pull the spring loaded label stock guide out far enough to fit the label stock.
3. Remove any shipping tape from your label stock roll to ensure that it can unroll freely, making certain that no adhesive portion is exposed. It is important to note that any exposed adhesive surface can attach itself to the inner workings of the print mechanism and cause a media jam.

**Note:** If you are using fan-fold label stock or label stock other than standard square / rectangular die cut labels, see Sections 2B and 2C for additional instructions.
4. Place the label stock between the stock guide rollers and release the spring loaded stock guide to hold the label stock. The stock guide rollers allow the label stock roll to move freely.

5. Place the leading edge of the label stock between the throat guide and the side of the printer.

6. Quickly continue feeding the label stock further into the printer until you feel resistance from the feed rollers. The printer will sense the label and automatically feed it through the printer. If the printer fails to feed the label stock, press the Load/Feed button to manually engage the feed roller while continuing to guide the label stock into the printer.
Tip! To ensure that the label stock is fed straight be sure to push the label stock into the printer quickly until the entire front edge of the stock is touching the feed roller. For wider stock use both hands to feed the stock to maintain even forward pressure while you are pushing the stock into the printer.

### B. ADJUSTING THE LABEL STOCK GAP SENSOR POSITION

The stock gap sensor (TOF Sensor) "sees" the gap between label stock by shining light from the top of the label and attempting to read that light from a sensor on the bottom. By default, this sensor is set to read the gap .5" from the left side of the label stock. If the gap in your label stock intersects with gap position as shown on the slide bar you do not need to adjust this and you can skip this section. This does not need to be adjusted for most label stock.
If you are using label stock other than standard square/rectangular die cut labels such as circular die-cut labels or through-hole stock use the instructions below to adjust the label stock TOF sensor.

### Circular Labels

If you are using Circular Labels you must adjust the Stock Gap sensor to correspond with the very top of the label where the circles are closest together. If the sensor is too far to the right or the left the printer will still sense the label but the image may be offset downward because the printer will start printing at the wrong position. If you are using stock that has multiple labels across make sure the sensor corresponds to a place on the stock that has a label and not a vertical gap.

The Sensor Bar has a guide in inches and millimeters that will help you identify where to set the bar to align the sensor over any identifying mark or top of a circular shape. To do this, measure the distance from the edge of the label stock to the correct position on the stock. Set the sensor bar to this measurement. For example, if you have a two inch circular die-cut label, measure from the edge of the label stock to the center of the circle. For this example it should be about 1 1/8 inches. Set the Sensor Bar to this value.
Through Hole Labels

If you are using card stock or label stock that has a hole punch or a notch to identify a transition from backing to label, you can adjust the Sensor Bar to position it over the identifying mark.

To adjust the sensor position use a pen to move the slide bar to the correct position.
C. USING FAN-FOLD LABEL STOCK

It is possible to use fan-fold label stock by feeding it through the fan-fold slot in the back of the printer.

Before feeding the fan-fold stock through the back of the printer, lock the stock guide in the out position so the stock guide rollers will not interfere with the label stock. The stock guide is spring loaded and under normal circumstances it will pinch any label stock roll inserted into the printer.

To lock the stock guide push the tab located on the bottom of the moveable stock guide to the out/locked position.

D. INSTALLING THE INK CARTRIDGE

When the cartridge reaches 10% remaining you will be prompted via the Status Monitor to replace the cartridge. If quality still looks acceptable you can choose to ignore this warning. However, you may waste labels if the cartridge runs out of ink before the next warning at 0%. If you choose to replace the cartridges follow the procedure below.

After installing a new cartridge, you may choose to run an alignment print to achieve maximum quality. However, this will require cancelling the print job. If you would like to enable smooth transitions between ink cartridge changes, you may choose to disable alignment print warnings. (See the next section).
1. Open the Top Cover of the printer.
2. Press the Ink Button on the printer.

3. The Cartridge Carrier will align itself to the center of the print area.
4. Press the Cartridge Cover Release to open the Cartridge Holder. Remove the cartridge (if installed).

5. Remove the new Cartridge from its packaging. Be sure to remove the protective tape covering the copper contacts.

6. Replace/install the cartridge copper end first.
7. Push cartridge cover downward until it snaps in place.

Note: Ink Cartridge Levels are estimates based on analysis of the printed images by the driver during spooling. This analysis estimates the number of ink droplets(spits) required to print the image and subtracts that amount from the total amount in the cartridge. It displays the total remaining spits as a percentage. In other words, there is no real time sensor that shows the actual amount of ink in the cartridge.

8. Press the Ink button on the printer to indicate the new cartridge is now installed. You will be prompted to align the cartridge. A warning will appear stating that you must have installed label stock that is equal to or larger than 4" x 2" (101.6 mm x 50.8 mm). If your label stock meets this requirement click OK to align the cartridge. If your stock does not meet this size requirement see the next section before clicking OK.
E. ALIGNING THE INK CARTRIDGE

Cartridge alignment will align the Color Cartridge for bidirectional printing and calibrate the printer to each individual cartridge. You will automatically be prompted to perform this alignment each time you install a new cartridge. You may also manually align the cartridge via the status monitor.

For Alignment you will need to have installed label stock that is equal to or larger than 4" x 2" (101.6 mm x 50.8 mm). If your stock does not meet this requirement you can use the sample roll that came with the printer for this purpose. You may also choose to disable alignment via the settings area of the status monitor.

**Disable Alignment:** If you would like to enable smooth transitions between ink cartridge changes, you may choose to disable alignment print warnings. Alignment improves print quality if Bidirectional printing is enabled. It is not necessary if Bidirectional printing is disabled via the printer driver.

You can disable alignment via the status monitor.

1. Open the status monitor.
2. Select the settings tab (fifth tab).
3. Uncheck "Require cartridge alignment for best quality."

![Image of Status Monitor]
Section 3: Primera PrintHub

Primera PrintHub is used to interact with the printer for gathering ink levels, maintenance, alignment, cost calculation and several other functions. You can use it to manage these functions on multiple LX500/RX500 printers and other Primera label printer models.

PrintHub automatically installs with your printer driver and can be accessed through the printer driver preferences or as a program on your Windows start menu.

1. Connect the printer via USB and turn on the power. The PrintHub accesses most of the information it uses from the printer itself so the printer must be turned on and communicating for the program to be useful.

2. Go to Start - Programs - Primera Technology - Primera PrintHub.

A. Adjust alignment, sensor mode, output mode, RFID settings and advanced settings.

B. If you have multiple Primera printers connected, they will be listed here.
C. Past jobs will show the last 5 jobs along with cost information. Click the document icon to view a cost report.

D. Application Settings

E. Print Queue shows the currently printing job.

F. Order Link

G. Frequent Activities

H. Current Ink Levels

A: MONITORING INK LEVELS

Ink levels can be monitored at any time by using the PrintHub. Immediately after printing starts the PrintHub will display the ink levels in the upper right corner of the application. Ink is displayed in 10% increments. Example 100% to 90% to 80%.
B. USING THE COST ESTIMATOR

The cost estimator is found under the queue section on the first tab of the PrintHub. The last five job costs are stored in the list. Each job will show the cost per label based on the cost per cartridge entered below the list. Enter the actual cost of the cartridge you paid. Prints remaining on the currently installed cartridge and total prints on new cartridge are both displayed.

To see a printable/savable report click on the document icon next to the job you want to see. A report will display the information. You can print or save the report from this screen. You can also change the currency using the drop down, change the job name or adjust the cost from this screen.
Important Note: The cost per label represents the average cost per label over an entire run of labels. This means that the per label cost will decrease and become more accurate as the number of labels printed increases. This is because the ink that is used for periodic cartridge maintenance is divided into a larger number of labels. Primera recommends printing at least 5 labels for an accurate per label cost.

C. SET THE STOCK SENSOR MODE

The stock sensor mode refers to the method the printer will use to detect the print starting position for each label. To adjust the stock sensor mode, open the PrintHub. In most cases you will NOT need to change this setting. By default, it is set to sense standard die-cut labels. It is only necessary to change this setting if you are using clear labels or any label with a black sensing mark on the back.

1. Connect the printer via USB and turn on the power. The Stock Sensor Mode setting is stored in the printer's internal memory so you will not be able to access it unless the printer is turned on and properly communicating with the computer.

2. Go to Start - Programs - Primera Technology - Primera PrintHub.

3. Click on the Label Feed (3rd tab from left).

4. Select the Stock Sensor Mode by clicking on the graphic that most closely corresponds to the stock you intend to install.

5. Load the label stock after you have set the sensor mode.
There are three sensor modes:

**Die-Cut (Default).** If you are using standard die-cut labels that look similar to the graphic, use this setting regardless of the size of the label. Also, use this setting for Through-hole label material where a hole is punched through each label or a notch is cut in the side.

**Reflective.** Use Reflective for label material where a black pre-printed line (black mark) on the back of the label stock indicates the break between labels. Black marks are required on clear label stock rolls, or label where the label waste matrix (waste) is left on the liner. Black marks can also be used for irregular shaped labels, circles larger than 4 inches or on any stock where the print starting position cannot be sensed using the label itself.

**Continuous.** (Sensor off) If you have continuous stock with no die-cut, reflective mark or holes, set the sensor type to Continuous. This will turn off the stock sensor. In this mode there is no way to set the print starting position. The printer will simply start printing the first label and print each subsequent label immediately after that previous one. To produce a gap between prints simply add the desired amount of white space to the end of the label being printed.

**Important Note:** You must also set the Stock Sensor Position (Section 2B) so that the sensor is sensing the correct point on the label stock.

### D. SET THE PRESENT OR CUT MODE (CUTTER MODELS ONLY)

Use the Present/Cut Mode to adjust how the printer presents labels after they are printed or if/when they are cut after printing. To adjust the Present/Cut Mode, open the PrintHub program.

1. Connect the printer via USB and turn on the power. The Output/Cut Mode Setting is stored on the printer main board so you will not be able to access it unless the printer is turned on and properly communicating with the computer.

2. Go to Start - Programs - Primera Technology - Primera PrintHub.

3. Click on the Label Feed Tab.
4. Click on the Output/Cut Mode button. There are different options available which change if the Cutter is enabled or disabled. If the Cutter is disabled, the label present options will be available. If the Cutter is enabled the present options are no longer available but cut options become available.

**Cutter Options**

**Cut after button press.** This setting will cut after you press the Load/Feed button on the printer. This can be used after one label or an entire job. This feature is useful if you will not be present at the end of the print to catch the cut label.

**Cut after label count.** This option will cut after the number of labels specified in the toggle box that appears when this option is selected. This is useful if you have front/back labels or sets of labels.

**Cut after no activity.** This setting will cut at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to cut at the end of multi-copy job, multi-page job or multiple individual jobs in the queue.

**Cut every label.** This setting will cut after every label.
Present Options

Do not present. In this mode the label stock does not move after the last label is printed. This means that part of the last label printed is still in the printer. This should be used only if you have a label rewinder attached.

Present after no activity. This setting will present (feed all printed labels past the tear off point) at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to present at the end of a multi-copy job, a multi-page job or multiple individual jobs in the queue.

Present Timer. (Works only with Present after no activity option) Set the time delay from the end of the job to when the label is presented. Increasing this value can resolve issues with unnecessary present actions between jobs.
If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11 inch paper you probably are not familiar with an essential part of a label printing - Print Alignment. Standard printers feed a sheet and start printing based on the start of the sheet. They also prohibit printing to the edge of the sheet. This is to avoid any need for alignment. The LX500/RX500 senses the beginning of the label with an optical sensor and is capable of printing to top, bottom, left and right edge. Because of this it is necessary to align the printer to work with specific types of label stock.

The LX500/RX500 comes factory calibrated to print exactly to the edge of Primera label stock. However, due to variations in the left margins and other variables it may be necessary to fine tune these settings at the beginning of each roll. This is especially true for other non-Primera brand label stock.

Adjust print alignment using the PrintHub. Go to the Print Alignment Tab (second tab).

**Important Note!** Before adjusting any values, print the Test Alignment to see how close you are to alignment. The on screen graphic is the same as the print which makes it easier to adjust these values.
Three items can be adjusted here:

1. **Tear off/Cut Position.** This value adjusts the position of the last label printed after it has been presented for tear off or for cutting. This only applies if the output mode is set to "Present the label." Add to the current value to move the tear point closer to the printer. Subtract from the current value to move the tear point away from the printer. The value is automatically saved as soon as you set it.

2. **Left Margin Offset.** This value moves the printed label left or right. Add to the current value to move the printed label to the right. Subtract from the current value to move the printed label to the left.

3. **Top of Form (TOF).** This value moves the print start position up or down on the label. Add to the current value to move the printed label down or toward the printer. Subtract from the current value to move the printed label up or away from the printer. The value is automatically saved as soon as you set it. You may have to make several adjustments to one or more of these values. After each adjustment you can click the Test Alignment button to print a small test pattern on the label. This will help you find the proper alignment value.

**F. SETTINGS**

There are two areas with Settings in PrintHub.

General application settings that apply to the software and all printers can be found by clicking the blue "Settings" button in the lower left. Printer specific settings can be found on the "Printer Settings" Tab.
General Settings

Language. Typically, the language is set to match the language setting in the operating system. However, you can override currency settings on the Language Tab.

Automatic Updates. Automatic Updates will update PrintHub, the printer driver and the printer firmware. Every 7 days you will be prompted to update the software if there are any newer versions. You can choose to increase or decrease that automate check. You can also perform a check for updates immediately by clicking the “Check for Updates” button. Finally, if you would like to receive beta software check the “Check for Beta updates” box.

Printing Preferences. You can choose to close PrintHub after printing completes by checking the “Close this application after printing completes” box. PrintHub automatically opens whenever you send a print job to the printer. If you do not want PrintHub to open in front of other programs, you can check the “Launch minimized during print” option.

Support. Click the “Generate Support Report” button to generate a zip file on your desktop containing all recent log files. Send this to tech support so they can help solve any printing problems.

Advanced. Check the “Generate Printer Status XML” box to create an XML at "C:\ProgramData\PTI\PrintHub\PrinterStatus.xml". Software developers can use this file to display status information such as error messages and ink levels in 3rd party applications.
Using RFID

**Printer Settings**

**Information.** This section displays all current driver, software and firmware versions.

**Cartridge Maintenance.** Here you can adjust the frequency of certain maintenance operations. Increasing the value of “Seconds between Maintenance Spits” will decrease ink usage but could also cause poor quality printing.

Increasing or Pages between Maintenance Wipes will speed up printing but could also cause poor quality printing.

Check the Suppress Alignment message to prevent the window from appearing which prompts you to align the cartridge every time a new cartridge is installed. Skipping the alignment is faster but can result in poor print quality.

---

**Color Label 500 - Idle**

<table>
<thead>
<tr>
<th>Queue</th>
<th>Print Alignment</th>
<th>Label Feed</th>
<th>RFID</th>
<th>Printer Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Information**

- **Driver**: Color Label 500 (1.40)
- **Firmware**: 2.04 1/28/2019 (11) 01.01
- **Serial Number**: 2180600207
- **Software Version**: 1.3.0.22

**Cartridge Maintenance**

- 5 ➔ **Seconds between Maintenance Spits**
- 28 ➔ **Pages between Maintenance Wipes**
- ✔ **Suppress Alignment**

**Advanced**

- 1 ➔ **USB Serial Number**
  - Generate
  - Set

  **Calibrate Paper Sensor**

  **Restore Factory Defaults**

---

24 Using RFID
**Multiple Printer Support.** You can install multiple printers to the same computer and use them simultaneously. To do so you will need to change the USB serial number identifier of one of the two printers, two of three printers, three of four printers etc. To change serial numbers:

1. Connect each new printer one at a time. The current USB Serial Number will be displayed.

2. Click Generate. It will find the next available USB Serial Number based on the currently connected printers. For the first one it should set it to 2 and for the next printer 3 and so on.

3. Click Set. You will hear the printer reset and the settings window will turn gray. After it resets you will be able to see the settings window again. Keep the printer connected.

4. Now you can connect the next printer. Windows will automatically install a new driver for that new printer and name it Color Label 500 (Copy 1). You can rename it later by editing the printer properties in the Windows printer list.

5. You will now see a second printer appear in the left column – Color Label 500 (Copy 1). Click on it to display information about this printer. If this is the last printer, you will connect you are done. If you wish to connect additional printers follow through steps 2-4.

**Calibrate Paper Sensor.** Calibrate the paper sensor if you are receiving TOF errors. The calibration process will prompt you to remove all paper/stock from the printer before calibrating.

**Restore Factory Defaults.** This will set all Print alignment and other calibration settings back to factory defaults.
A. SETUP RFID

Label Stock should have an antennae imbedded between the label adhesive layer and the liner. The antennae should be oriented to the front of the label stock and centered within the label.

The RX500 has a fixed RFID Encoder/Sensor which is in the middle of the print area. Each time a job with RFID encoding is sent to the printer the printer will automatically find and calibrate to the installed tag. If you would like to determine if the RFID Tags are detected before then you can check on the RFID tab within Primera PrintHub.

To test the RFID stock, click the Start Read/Write button.

The RX500 will write and read the chip until you press the “Stop Test” button.
If successful, you will see the Success entry for each attempt. If the stock fails the test for any reason, stop the test and try pressing the Auto-Calibrate button. If the stock is still not writing/reading refer to the RFID tag specifications at the end of this section to make sure your stock is compatible.

**B. PRINTING AND ENCODING**

Once you have a successful write test, you are ready to print from your RFID equipped software program! Refer to the printing application’s documentation for details on RFID printing. A trial version of Bartender is included on the installation disc. You will have to start the 30-day trial on at least the Professional version to encode RFID.
To add RFID encoding to a label design using Bartender, once the label size has been chosen and the blank label is on screen, click the Standard RFID button on the lower left to display all RFID options. Simply drag the desired data format to the area around the label. Double click on the icon that appears to set the data or data source.

**Note on Encoding Errors:** During printing from any application if an encoding error appears, PrintHub will appear and display an error. It will try to encode again after making calibration adjustments. If it fails to encode, by default a series of XXXXs will automatically be printed on the label to indicate that it was not encoded properly. The job will then continue.

C. **TAG SPECIFICATIONS**

Tags must meet the following specifications to be encoded using the RX500:

- EPC Gen 2 (v1.2.0) compliant
- ISO/IEC 18000-6C compliant
- 915 MHz (UHF) for USA (Requires USA version of RX500)
- 867 MHz (UHF) for Europe (Requires European version of RX500)

RX500 encodes only to EPC memory which can store from 96 bits to 480 bits depending on the tag that is chosen.

The chip (ICs) for Gen 2 tags contain four types of memory:

- Reserved memory
- EPC memory
- TID memory
- User memory
Reserved Memory:
This memory bank stores the kill password and the access password (each are 32 bits). The kill password permanently disables the tag (very rarely used), and the access password is set to lock and unlock the tag’s read/write capabilities. This memory bank is only writable if you want to specify a certain password. Most users do not use this memory area unless their applications contain sensitive data. It cannot store information besides the two codes.

EPC Memory (RX500 Only Encodes this Memory):
This memory bank stores the EPC code, or the Electronic Product Code. It has a minimum of 96 bits of writable memory. The EPC memory is what is typically used in most applications if they only need 96 bits of memory. There are some tags that have the capability of allocating more bits to the EPC memory from the user memory. EPC memory is your first writable memory bank.

TID Memory:
This memory is used only to store the unique tag ID number by the manufacturer when the IC is manufactured. Typically, this memory portion cannot be changed.

User Memory:
If the user needs more memory than the EPC section has available, certain ICs have extended user memory which can store more information. When it comes to user memory, there is no standard in how many bits of memory are writable on each tag. Typically, the extended memory is no more than 512 bits, but there are some high memory tags with up to 4K or 8K bytes of memory. This is the second writable memory bank for Gen 2 ICs.

Note: For specs on the physical placement of the tag on the label please see Label and Roll Specifications.
A. USING BARTENDER®

Primera Special Edition BarTender UltraLite is included with the printer. Other programs can be used to print. If printing from other programs please follow the guidelines in Section 3D.

When you open BarTender you will be given the choice to select an existing label or create a new one using a wizard. Use the following instructions as a general guide for standard labels.

1. Choose "Start a new BarTender document..."
2. Select "Blank Template". Click "Next".

3. Select "Color Label 500". Click "Next".

4. Select "Specify Custom Settings". Click "Next".
5. Set the page size, width and height to match labels installed in the printer. Click "Next".

6. Check the "Picture" box to add a background photo or graphic to your label. Click "Next". If you click "Finish", the remaining default wizard options will be set and no picture will be added.
7. Select "Embedded Picture". Click the "File" Button to browse to the location of your photo/graphic file. Set the Size Method to "Stretch". Note the preview to the right. Click "Next" if you are satisfied with the layout of the photo or graphic.

8. Review the label setup summary. If it is correct, click "Finish". Your blank label will be displayed.

After you click Finish, you can always go back and change any of these settings, by going to the File Menu and selecting "Page Setup". Basic and advanced settings are available on the various tabs.
B. ADD TEXT, BARCODES AND GRAPHICS TO A BARTENDER LABEL

Once you have created your label size you will need to add text, a barcode and/or graphics. This can be done using one of the buttons on the button bar at the top of the screen.

**Add Text.** Click the Text button. Now click anywhere on your label. "Sample Text" will appear. Edit the text on screen or double click it to open up text settings to change font, size and other settings.

**Add Graphic.** Click the Image button. Now click anywhere on your label. An Image icon will appear. Double-click it to open up image settings and browse to the image/graphic that you would like to insert.

**Add Barcode.** Click the Barcode button. Now click anywhere on your label. A barcode settings window will appear. Here you can choose any type of barcode and enter the value.

**Print.** Click the Print button to start printing.

**Page Setup.** Click the Page Setup button to change your label size, adjust corner radius or change the shape.

**Lines.** Click the Line button to add a horizontal or vertical line.

**Tip!** Double-click any object to open settings for that object.

**Tip!** Go to the Help menu to access the BarTender Manual and Tutorials.
C. PRINTING FROM BARTENDER

1. To print, click the Print button or go to the File Menu and select "Print". The Print Dialog window will appear.

2. Select the Color Label 500.

3. Set the number of copies.

4. Click "Document Properties" to adjust print quality settings. These settings are explained in the next section.

5. Click "Print".
Settings changed via the method below will apply to all new designs created in BarTender or other programs after the preferences were changed. Existing labels saved in BarTender will not be affected since the preferences are saved with the label. To change these preferences you will have to change printer preferences through BarTender before printing by clicking the "Document Properties" button.

**To find Driver Settings:**

Click the **Start** button, choose **Printers and Faxes**. Right-click on the Color Label 500 Icon and select Printing Preferences from the drop-down menu.

The preferences screen will appear.
NOTE on PC Settings:

Most applications allow you to change these same printer driver options from their "Print" screens. Some applications such as BarTender save your settings with the label, others use settings only for the current print job just sent to the printer.

Paper Size

If you are using BarTender, this setting is adjusted during the label setup wizard. If you are using a program other than BarTender you will need to set this to the dimensions of your label. Keep in mind that the dimensions are always relative to the width and height of the actual label in the printer. Orientation of an image on the label should not change this setting. See Section 6 for minimum and maximum label sizes.

Orientation

There are two settings for orientation, Portrait and Landscape. If your text and graphics print left to right or as shown on the screen, select portrait. If you wish your printing to rotate 90 degrees from what you see on the screen so it is printing horizontally, select landscape as your orientation. Remember, this does not change the width and height in the Paper Size setting. It is only a tool for viewing a label upright on screen that will be printed sideways on the printer.

<table>
<thead>
<tr>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Portrait Image]</td>
<td>![Landscape Image]</td>
</tr>
</tbody>
</table>
Print Quality

There are 4 levels of print quality in the driver. The lower the Quality, the faster the print. Quality 1 provides the fastest print available while Quality 4 provides the best quality. It is recommended that you experiment with the different levels when designing your label to find a good balance between print quality and print speed.

Color Matching

Best for Graphics mode is best used for graphical images where accurate color reproduction is not as essential. Images printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of people may produce skin tones that have a reddish tint.

Best for Photos mode is best used for photographic images where accurate color reproduction is very essential. Images printed in this mode will look lighter than those printed in Photo mode. Skin tones especially will look more natural in this mode.

NOTE: Exact color matching of the printed labels to the screen may never be possible since there are factors that affect this out of the driver’s control. The surface of the label reacts with the ink in the cartridge to produce the color. For this reason, when printing the same image to different types of labels with different surfaces the printed output can look entirely different.

Ink Saturation

This option controls the amount of ink used when printing an image. The default setting is 100%, which will provide the most accurate color matching. If the ink is not drying fast enough or is bleeding, you can decrease the Ink Saturation to lessen the amount of ink that is applied to the label.

Enable Bidi (Bidirectional) Printing

Set to "Yes" for fastest print speed. Requires an alignment print after every cartridge change. Set to "No" for better quality print (in some cases).
Launch Status Monitor

Click here to open the LX500 Status Monitor. See section 3 for more details.

Details/Print Counter

Clicking on the Details button will allow you to view information about printer settings stored on the printer. There is also a print counter in the details window to help you count the number of labels printed since the last time it was reset. Click Reset Counter to set the counter to zero.

E. PRINTING FROM OTHER PROGRAMS

Since this printer uses a standard Windows printer driver you can print from any application you would like. There are just a few things to remember that will make it much easier.

1. Set the Page/Label Size in the Driver. BarTender automatically prompts you for the size of the label that you are using. When printing from any other program you must do this manually. Before you print, simply set the Paper Size just as you would set print quality in the printing preferences. In the example below the label size is 4" x 4" so the custom page size is set to 400 x 400 (displayed in .01 inch units).
2. **Check the image or document size.** The image size or document size should correspond to the Page/Label Size set in the driver. If you have set your page size in the driver to 4" x 4" but your image is actually 5" x 3" the printer driver will automatically shrink your image to fit inside the 4" x 4" label. The result is that the actual printed label is 4" x 2.4". Avoid this by setting your page size in the driver and image size in the printing application to match the label size installed in the printer.

3. **Choose the right printing program.** There are many different applications that are capable of printing to the LX500. However there are only a few that are ideal printing applications. For example, Adobe Illustrator is an excellent design program but is not always the best printing program. It can be difficult to find the printing preferences or to know the exact size of the art board. It is best to save as a PDF file and print from Adobe Reader or export as a 300 dpi JPG and print from BarTender.
Section 6: Printing from a Mac

A. PRINTER UTILITY SETTINGS (COLOR LABEL 500 UTILITY)

The Color Label 500 Utility is used to interact with the printer for gathering ink levels, maintenance, alignment, and several other functions.

To Find Color Label 500 Utility:

Color Label 500 Utility automatically installs with your printer driver and can be accessed through the Printer & Scanners in Mac under Apple Icon – System Preferences.

1. Connect the printer via USB and turn on the power. The Color Label 500 Utility accesses most of the information it uses from the printer itself so the printer must be turned on and communicating for the program to open.

2. Go to the Apple Icon – System Preferences - Printers and Scanners, select the PTI Color_Label_500, click on, Options & Supplies, and Open Printer Utility. Or you may simply print to the printer and the Utility will open. The Color Label 500 Utility has 4 tabs that are arranged on the top of the window. Each tab opens a screen that has various similar functions.
- **Status Tab** (First Tab). Displays ink levels, print counter and any error messages.

- **Cartridge Tab** (Second Tab). Use for aligning the cartridge, cleaning the cartridge, and changing cartridge.

- **Alignment Tab** (Third Tab). Adjusts vertical and horizontal print alignment. Changes the Stock Sensor Mode and toggles the Output/Cut Mode.

- **Settings Tab** (Fourth Tab). Displays printer information including firmware version, driver version, and software version. Check for updates and set other advanced settings.
B. ADJUSTING PRINT ALIGNMENT/LABEL OFFSETS

If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11 inch paper you probably are not familiar with an essential part of label printing – Print Alignment. Standard printers feed a sheet and start printing based on the start of the sheet. They also prohibit printing to the edge of the sheet. This is to avoid any need for alignment. The LX500 senses the beginning of the label with an optical edge. Because of this it is necessary to align the printer to work with specific types of label stock.

The LX500 comes from the factory calibrated to print exactly to the edge of Primera label stock. However, due to variability it may be necessary to fine tune these settings at the beginning of each roll. This is especially true for other non-Primera brand label stock.

Important Note: Before adjusting alignment settings first print one label at the quality level you intend for the entire print job. This will ensure the label stock is moving at the same speed and the stock sensor will sense the gap in the same way.

Adjust print alignment using the Color Label 500 Utility. Click on the Alignment Tab (Third Tab).
Three items can be adjusted here:

* **Tear off Position.** This value adjusts the position of the last label printed after it has been presented for tear off. This only applies if the output mode is set to “Present.” Add to the current value to move the tear point closer to the printer. Subtract from the current value to move the tear point away from the printer. After adjusting the value click the Set Offsets button to send the value to the printer.

* **Left Margin Offset.** This value moves the printed label left or right. Add to the current value to move the printed label to the right. Subtract from the current value to move the printed label to the left. After adjusting the value, click the Set Offsets button to send the value to the printer.

**Note:** Before adjusting this value make sure the label stock is properly loaded so that there is no gap between the edge of the liner and the fixed throat guide. Any gap at this point will greatly affect the Left Margin Offset value needed to align the label. Also, if you adjust the value with improperly loaded label stock you will have to adjust it again if you load the label stock correctly the next time.

* **Top of Form (TOF).** This value moves the print start position up or down on the label. Add to the current value to move the printed label down or toward the printer. Subtract from the current value to move the printed label up or away from the printer. After adjusting the value click the Set Offsets button to send the value to the printer.

You may have to make several adjustments to one or more of these values. After each adjustment you can click the Test Offsets button to print a small test pattern on the label. This will help you find the proper alignment value.
C. SET THE STOCK SENSOR MODE

The stock sensor mode refers to the method the printer will use to detect the print starting position for each label. To access the Stock Sensor Mode, click on the Alignment button, then select Stock Sensor Mode. In most cases you will not need to change this setting.

Important Note: Set the Stock Sensor Mode **BEFORE** loading label stock! You must also set the Stock Sensor Position (Section 2B) so that the sensor is sensing the correct point on the label stock.

**Die Cut (Default).** If you are using standard die-cut labels that look similar to the graphic use this setting regardless of the size of the label. Also, use this setting for through-hole label material where a hole is punched through each label or a notch is cut on the side.

**Reflective.** Use Reflective for label material where a black pre-printed line (black mark) on the back of the label stock indicates the break between labels. Black marks are required on clear label stock rolls, or labels where the label waste matrix (waste) is left on the liner. Black marks can also be used for irregular shaped labels, circles larger than 4.6 inches or on any stock where the print starting position can not be sensed using the label itself.
Continuous. (Sensor off.) If you have continuous stock with no
die-cut, reflective mark or holes, set the Sensor Type to
Continuous. This will turn off the stock sensor. In this mode
there is no way to set the print starting position. The printer
will simply start printing the first label and print each
subsequent label immediately after the previous. To produce a
gap between prints simply add the desired amount of white
space to the end of the label being printed.

D. SET THE OUTPUT MODE

Use the Present/Cut Mode to adjust how the printer presents
labels after they are printed or if/when they are cut after
printing. There are different options available which change if
the Cutter is enabled or disabled. If the Cutter is disabled the
label present options will be available. If the Cutter is enabled
the present options are are no longer available but cut options
become available.

Cut Options (Check Cutter Enabled):

Cut after no activity. This setting will cut at the end of a print
job if the printer does not receive another print job within one
second of the last print job in the queue. You can use this feature
to cut at the end of multi-copy job, multi-page job or multiple
individual jobs in the queue.

Cut after button press. This setting will cut after you press the
Load/Feed button on the printer. This can be used after one
label or an entire job. This feature is useful if you will not be
present at the end of the print to catch the cut label.

Cut every label. This setting will cut after every label.
**Cut after label count.** This option will cut after the number of labels specified in the toggle box that appears when this option is selected. This is useful if you have front/back labels or sets of labels.

**Present Options (Uncheck Cutter Enabled)**

**Do not present.** In this mode the label stock does not move after the last label is printed. This means that part of the last label printed is still in the printer. This should be used only if you have a label rewinder attached.

**Present after no activity.** This setting will present (feed all printed labels past the tear off point) at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to present at the end of a multi-copy job, a multi-page job or multiple individual jobs in the queue.
You can print to the printer from any program. However, Belight’s Labels and Addresses is an affordable program that we recommend. It saves time by eliminating the need to setup a custom page size for each label. You may download a trial version at their website: www.belightsoft.com

To setup a label and print follow these instructions.

1. When you open the program for the first time, a label assistant will be displayed. You may choose a predefined label if your label size is on the list.
2. If your size is not on the list, select ANY label and click Choose. You will have to setup a new label before it will appear on the Custom tab. Click on the information icon to display label size information. Click on Change Layout…

3. Click on the Custom Tab. Choose Create New. Click OK.
4. The setup will contain a default name and setup. All of this information needs to be changed. First change the name to match your label size.
5. Change the Label Size and Layout. Use this information as a guide. In this example we will setup a 2.5” wide x 2” high label.

- Label Width and Height should match Page Width and Height
- A standard corner radius (rounded corner) is .125
- Paper Size should be set to “Other”
- Rows and Columns should be set to 1
- All Margins should be set to zero
- All Spacing should be set to zero
6. Click OK when the label is setup. Now select the label you setup from the Custom Tab. Click OK.

7. Add images, barcodes or text using the buttons across the top ribbon. For more information on how to setup a label and use the software, contact Belight or visit the Help menu. When you are ready to print, go to the file menu – print.
8. Choose the Color Label 500 as the printer and click Next.

9. You may print at this point. However, if you wish to adjust print settings, click on the Show Details button.

11. Set your Saturation, Ink and Quality settings according to the guide in section 5F. Click Print.
F. CREATE A CUSTOM LABEL SIZE /PRINTING FROM OTHER PROGRAMS

In many programs such as Adobe Illustrator, Photoshop or Acrobat Reader you will need to choose your label/page size before you print. If the label size you need to use is not already on the list of available pages sizes you will need to create a new custom size.

1. Open the program you would like to print from and select File – Page Setup. Using the Paper Size drop down menu select Manage Custom Sizes.

2. Add a New Custom Paper Size. Click the plus (+) button to add a new custom paper size. Enter the size on the right. Be sure to adjust the top, bottom, left and right margins to 0. Change the name from "untitled" to the size of your custom page (W x H).
G. CREATING A FULL BLEED PRINT

1. If you are having trouble making the image cover the entire label, first make sure the image is printing at least as big as the label size you have selected. Increase the selected page size by .03 inches on the width and .03 inches on the height to create an over bleed.

**Note:** Make sure under scaling options to select ‘Fit to Page’ in the print dialogue box if printing from Illustrator.

**Left Margin Offset.** You must decrease the Left Margin Offset to center the over bleed on the label. If you over bleed by .03 inches, you will need to decrease the Left Margin Offset by 4. This will center the page size increase so there is an over bleed on both the left and right sides.

**TOF.** Increase the Top Of Form by 4. This will cause the printer to start printing before the label and ensure a fully printed label.

![Image of LX500Config interface showing Label Offsets with Top of Form (TOF) set to -1, Tear Off/Cut Position set to 0, Left Margin Offset set to 0, and Cutter Offset set to 0.]

**Note:** It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over bleeding too much will cause the printer to skip labels. This is because the printer stops printing too late to sense the next label.
Printer driver settings are accessible on the print window of any application right before you click print.

**Printing from Preview:**

Click on the Layout dropdown menu and choose Printer Features.
Printing from Adobe Reader:

First click on Printer... to access settings. Click on the Layout dropdown menu and choose Printer Features.
Print Quality

There are 4 levels of print quality in the driver. The lower the Quality, the faster the print. Quality 1 provides the fastest print available while Quality 4 provides the best quality. It is recommended that you experiment with the different levels when designing your label to find a good balance between print quality and print speed.

Color Matching

Best for Graphics mode is best used for graphical images where accurate color reproduction is not as essential. Images printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of people may produce skin tones that have a reddish tint.

Best for Photos mode is best used for photographic images where accurate color reproduction is very essential. Images printed in this mode will look lighter than those printed in Photo mode. Skin tones especially will look more natural in this mode.

NOTE: Exact color matching of the printed labels to the screen may never be possible since there are factors that affect this out of the drivers control. The surface of the label reacts with the ink in the cartridge to produce the color. For this reason, when printing the same image to different types of labels with different surfaces the printed output can look entirely different.

Ink Saturation

This option controls the amount of ink used when printing an image. The default setting is 100%, which will provide the most accurate color matching. If the ink is not drying fast enough or is bleeding, you can decrease the Ink Saturation to lessen the amount of ink that is applied to the label.

Enable Bidi (Bidirectional) Printing

Set to "Yes" for fastest print speed. Requires an alignment print after every cartridge change. Set to "No" for better quality print (in some cases).
A. SOLVING OFFSET/ALIGNMENT PROBLEMS

Image is Vertically Offset
(White space can be seen on the top or bottom of the label)

The LX500 decides where to start printing by detecting the start of a die-cut label, detecting a black mark on the back or detecting a thru-hole that corresponds to the start of the label.

The following items can cause the label sensor to improperly detect the start of a label:

1. **TOF Offset.** TOF stands for Top of Form and this setting allows you to fine tune the alignment of your printing on your label stock. This will be factory calibrated. If fine tuning is needed, increase this setting to move the image down on the label; decrease this setting to move the image up on the label. The unit of measure is 0.1mm.

2. **Nonstandard / Non-translucent Backing Material.** Test the unit with the label sample material that came with the unit. If it prints correctly, your label stock may not be compatible. The label sensor needs to see the difference between a label and a backing material by seeing through the label stock for light variations. If it can not see through the label, problems will arise. If you must use this type of backing, try label stock that has a black mark on the back to show where the label begins. You will need to change the Sensor Type setting in the driver preferences to Reflective if you switch to a label with a black mark on the back.

3. **Improper Label Gap Distance.** See Section 8 for label specifications.

4. **Page Size is Bigger than Label Stock Size.** If the page size set in the driver is larger than the actual label stock, ink will be printed on the gaps and the sensor will start looking for a gap too late. This can cause label skipping or inconsistent print starting points.
5. **Portrait / Landscape.** If the Portrait / Landscape setting does not correspond to the label stock installed this will also cause the printer to print over the gap and onto the next label. Make sure this is set correctly.

6. **Sensor Position.** Circular, nonstandard label shapes or multiple labels across will require precise adjustment of the label sensor. If you are using circular or other non rectangular die-cut labels see Section 2B for instructions.

**The image is printing horizontally offset**
* (White space is seen on the left or right side of the label)*

Two printer driver settings can affect this issue.

**Left Margin Offset.** This adjustment is found in the Status Monitor. If you see white space on the right side of the label and overlap on the opposite side, increase the number. If you see white space on the left side of the label and overlap on the opposite side decrease the number (Negative numbers are allowed).

**Note:** Usually a space on the right side indicates a margin around the label that is not being accounted for. The printer is factory calibrated for a 2mm margin. A larger margin around the label will cause a right side space.

**Page Size.** Often the page size is not large enough for the label. If this is the case you may see white space on the right side of the label and no image overlap on the opposite side. This indicates that the page size needs to be increased. Increase the page size through the printer preferences enough to cover the label.
B. CREATING A FULL BLEED PRINT

1. If you are having trouble making the image cover the entire label, first make sure the image is printing at least as big as the label size you have selected. To accomplish this using BarTender, make the image a few millimeters larger than the label by dragging the image over the edge of the label on all sides. The bounding box around the image will turn red when it is over the edge of the label. Try printing again to see if it covers the entire label. If not, move on to step two.

2. Adjust these settings in the printer driver preferences:

   **Page Size.** Increase the page size width in the driver preferences by .05 inches. Increase the height by .05 inches. If you are using BarTender, simply change the size under the File Menu - Label Setup. Increase the size of the image to fit the new larger page size. If you are using other graphics programs you will need to change the page size in the application and in the printer driver preferences.

   **Left Margin Offset.** Decrease the Left margin offset by half the increase of the page size width. In this case you would decrease the value by 6 (which corresponds to .025 inches). This will center the page size increase so there is a .025 inch over bleed on both left and right sides.

   **TOF.** Increase the Top of form by 6. This will cause the printer to start printing before the label and ensure a fully printed label.

**Note:** It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over bleeding too much will cause the printer to skip labels. This is because the printer stops printing too late to sense the next label.

62 Troubleshooting
C. CLEARING A LABEL JAM

If there is a label jam in the printer mechanism first attempt to remove the jam by opening the cover and removing the jam from the printer feed output area.

If the jam can not be located, it is possible to remove a cover over the feed input area. Pull on the center of the cover as shown below to release the tabs on the sides.

To prevent future jams, use rubbing alcohol to remove any adhesive left in the printer feed area.

D. MAINTENANCE

Cleaning the Printer

The case of the printer can be cleaned with an ammonia based window cleaner and a lint-free cloth.

Over time, ink overspray may gather at the base of the printer. The printer is designed using a vacuum system to gather most of this ink on a series of saturation pads. Eventually, these pads may need to be replaced. Contact tech support to determine if pad replacement is necessary.
Maintenance Station Cleaning/Wiper Replacement

Check the Maintenance (Capping) Station for ink build up / Replace Wipers. The capping station is where the cartridges dock when not printing. The rubber cap just naturally builds up ink over time. There can also be ink residue on the wiper. Wipe off the capping station components occasionally with a damp cloth. The components that need cleaning include the cap itself as well as the rubber wiper just to the right of the cap.

Wiper Replacement.

If you notice that the first few labels print fine and then the colors fade away, the wiper may actually need replacement. Wipers last approximately 30,000 prints. However, actual wear will depend on several factors including the size of the label you are printing. For this reason, the wiper should be cleaned and checked for wear every 10,000 prints. A replacement wiper can be purchased from the replacement parts store. SKU: 626367 Instructions for replacement can also be found on the parts store.

How will I know a wiper is worn?

The wiper has blades at the top that can get rounded over time. This rounding can be very subtle when viewing only the worn wiper but when comparing a worn wiper to a new wiper the difference is noticeable.

Note: These same symptoms can be caused by an empty cartridge. Please ensure the cartridge has at least 20% ink remaining. If not, please try a new cartridge.
E. POOR PRINT QUALITY - CLEANING THE CARTRIDGE

It may be necessary to clean the ink cartridge nozzles if you notice reduced print quality, or if you suspect a cartridge nozzle has become slightly dried out or clogged. If the cartridge has been left out of the printer more than 30 minutes, the ink in the print head nozzles may have dried. If you are having print quality problems, follow the steps below:

1. Before moving on to the next step, ensure that the ink level of the color cartridge is more than 10%. If the ink level is lower than 10%, replace the cartridge.

2. Try cleaning the cartridge using the clean function in the PrintHub or Printer Utility (Mac).

3. Determine if printing is now acceptable by printing your image.

   If the sample has missing colors or voids within a color strip, remove the cartridge from the printer and proceed to step 4.
4. Prepare items needed for procedure.

Two Paper Towels
folded four times each

A Glass of Water

5. Soak the paper towels in water for 5 seconds.

Note: Do not squeeze water from paper towels after removing from water.
6. Place one paper towel on cartridge nozzles. Gently press the paper towel with your finger. Leave the paper towel on the nozzles for 30-40 seconds.

7. Wipe nozzles.

A. Place second paper towel on flat/hard surface.
B. Press the nozzles into the paper towel.
C. Firmly tap the top of the cartridge three times to force the ink out.
D. Wipe/Drag the cartridge in the direction indicated.
E. Repeat until all colors are seen on the paper towel.

After wiping the nozzles, the paper towel should show all three colors.

If all three colors are present, proceed to step 8.

If the paper towel doesn’t show all three colors, then repeat step 7.

If paper towel still doesn't show all three colors repeating step 7, then replace the cartridge.
8. Dry cartridge.

Dry excess water from cartridge. Ensure cartridge contacts are completely dry. Printer damage may result if cartridge contacts are not completely dry.

9. Verify cartridge is now functioning properly by printing your label.

F. TECHNICAL SUPPORT

If you have difficulties operating your Printer, contact technical support using one of the methods listed below.

<table>
<thead>
<tr>
<th>Source</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primera Knowledge Base</td>
<td><a href="http://www.primera.com/kb">www.primera.com/kb</a></td>
</tr>
<tr>
<td>BarTender Software Help files</td>
<td>Open the software. Click on the Help Menu - BarTender Help</td>
</tr>
<tr>
<td>Email Support</td>
<td><a href="http://www.primera.com/contact_tech_support.cfm">www.primera.com/contact_tech_support.cfm</a></td>
</tr>
<tr>
<td>Phone Support</td>
<td>763-475-6669 (Mon - Fri 8 a.m. - 6 p.m CST)</td>
</tr>
<tr>
<td>Chat</td>
<td><a href="http://www.primera.com/contact_tech_support.php">http://www.primera.com/contact_tech_support.php</a> (Mon - Fri 8 a.m. - 6 p.m CST)</td>
</tr>
</tbody>
</table>
**Important!** Test all custom made label stock with the intended printer before ordering large quantities! Primera will only assume responsibility for custom label stock ordered from Primera.

### Label Sensing Methods

**Method 1: Label Gap Sensing**

- Label Width
- Liner Width
- Gap Between Labels
- Distance from edge of Media to edge of Label

**Method 2: Width of thru-hole opening Sensing**

- Width of Opening
- Distance from edge of Media to edge of Label

**Method 3: Reflective/Black Mark Sensing**

(Black Mark must be printed on back side of label stock)

**RFID:** Antenna inlay should be 0.25” (6.35mm) +/- 0.08” (2mm) from leading edge of label. If your inlay varies from this recommended specification, run the calibration described in Section 3A.

*Note: See table below for Max and Min values in inches and mm.*
<table>
<thead>
<tr>
<th>Specification</th>
<th>Max</th>
<th>Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label/Print width</td>
<td>4.25&quot; (108mm)</td>
<td>0.75&quot; (19mm)</td>
</tr>
<tr>
<td>Liner width</td>
<td>4.25&quot; (108mm)</td>
<td>1&quot; (25.4mm)</td>
</tr>
<tr>
<td>Label height/length</td>
<td>24&quot; (609.6mm)</td>
<td>0.75&quot; (19mm)</td>
</tr>
<tr>
<td>Gap between labels</td>
<td>0.75&quot; (19mm)</td>
<td>0.10&quot; (2.5mm)</td>
</tr>
<tr>
<td>Width of thru-hole opening</td>
<td>0.5&quot; (12.7mm)</td>
<td>0.375&quot; (9.5mm)</td>
</tr>
<tr>
<td>Distance from edge of media to edge of thru-hole</td>
<td>1.90&quot; (48.3mm)</td>
<td>0.20&quot; (5.1mm)</td>
</tr>
<tr>
<td>Reflective/Black Mark Width*</td>
<td>Equal to distance between labels</td>
<td>0.10&quot; (2.5mm)</td>
</tr>
<tr>
<td>Max Outer Diameter (OD)</td>
<td>5.0&quot; (127mm)</td>
<td>N/A</td>
</tr>
<tr>
<td>Inner Core Diameter (ID)</td>
<td>see roll specifications below</td>
<td></td>
</tr>
<tr>
<td>Stock Thickness**</td>
<td>.0010&quot; (10 mil)</td>
<td>N/A</td>
</tr>
<tr>
<td>Distance from edge of media to edge of label</td>
<td>Printer driver assumes 2 mm gap. However, this is adjustable via the left margin offset.</td>
<td></td>
</tr>
</tbody>
</table>

* The Reflective/Black Mark should be opaque to infrared light. The mark should be between the labels. The end of the mark should correspond with the beginning of the next label.

**This is the recommended maximum. There are two factors that determine whether the printer will accept any particular stock thickness.

1. The ability for the printer to pull the paper through the print area.
2. The ability for the sensor to read through the backing if the sensor is set to die-cut.

If you are printing in continuous or reflective label sensing mode number 2 does not apply. The fact that the printer must read through the backing in die-cut mode will limit the thickness much more than the printer’s ability to pull the paper through the print area. However, if you adjust opacity level of the liner enough to allow the label to be seen by the stock sensor, the thickness will only be limited by the printer’s ability to pull it through the printer area. For these reasons the weight or thickness of the liner is a variable that can not easily be defined. Primera recommends and uses 40# liner with all label stock.
Roll Specifications

Notes:
1. Label height ≤1.5” requires a 2.00” I.D. x 3.00” O.D. core. Label height >1.5” requires a 2.00” I.D. x 2.25” O.D. core.
2. Turret glue or 1/2”-wide 3M 928 double-sided removable tape must be used to attach stock to core. Removable tape must be positioned across full width of core. Other types of tape are not allowed.
3. End face of liner must align with end of core on both sides within 0.030”. (Core width should be the same as liner width.)
4. Masking tape or equivalent may be used to secure label stock to outside of roll.
<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Method</td>
<td>Inkjet</td>
</tr>
<tr>
<td>Print Resolutions</td>
<td>4800 x 1200 dpi, 1200 x 1200 dpi, 600 x 600 dpi</td>
</tr>
<tr>
<td>Ink Cartridge</td>
<td>#53374 Color (CMY)</td>
</tr>
<tr>
<td>Colors</td>
<td>16.7 million</td>
</tr>
<tr>
<td>Media Types</td>
<td>Roll-fed pressure-sensitive labels, roll-fed tags</td>
</tr>
<tr>
<td>Media Sensing</td>
<td>Moveable see-through sensor for die-cut labels and reflective for tags</td>
</tr>
<tr>
<td></td>
<td>with black stripe sensing</td>
</tr>
<tr>
<td>Ink Level Warning</td>
<td>Calculates actual number of prints remaining based upon ink usage of</td>
</tr>
<tr>
<td></td>
<td>graphics being printed (patent-pending)</td>
</tr>
<tr>
<td>Indicator Lights</td>
<td>Power, Ink</td>
</tr>
<tr>
<td>Controls</td>
<td>Ink, Load/Feed, Unload</td>
</tr>
<tr>
<td>Operating Systems</td>
<td>Windows 7/8/10, Macintosh OS X</td>
</tr>
<tr>
<td>Data Interface</td>
<td>USB 1.1</td>
</tr>
<tr>
<td>Minimum System</td>
<td>Pentium® IV computer or better, 512MB RAM, 5GB free hard drive space,</td>
</tr>
<tr>
<td></td>
<td>USB 1.1/2.0 port</td>
</tr>
<tr>
<td>Software</td>
<td>Can also be used with most other popular Windows and Macintosh label</td>
</tr>
<tr>
<td></td>
<td>design software programs</td>
</tr>
<tr>
<td>RFID Module</td>
<td>Compliant with EPC Global Class 1 Gen 2 and ISO 18000 -6B and -6C</td>
</tr>
<tr>
<td>Electrical Rating</td>
<td>12VDC, 5.0A</td>
</tr>
<tr>
<td>Power Requirements</td>
<td>100-240VAC, 50/60 Hz, 60 watts</td>
</tr>
<tr>
<td>Certifications</td>
<td>UL, UL-C, CE, FCC Class B</td>
</tr>
<tr>
<td>Weight</td>
<td>7 lbs.</td>
</tr>
<tr>
<td>Dimensions</td>
<td>10.4” wide X 15.3” deep X 7.1” high (closed)</td>
</tr>
<tr>
<td></td>
<td>17.4” high (open)</td>
</tr>
<tr>
<td>Warranty</td>
<td>One year, parts and labor</td>
</tr>
</tbody>
</table>
Automatic Update ................................................................. 23
Calibrate ................................................................................ 13, 25
Cartridge Alignment .............................................................. 13
Cleaning Ink Cartridge .......................................................... 65
Cost Estimator ........................................................................ 16
Cut Mode ................................................................................ 18
High Gloss Label Stock .......................................................... 2
Ink Low LED ........................................................................... 3
Installing the Ink Cartridge ...................................................... 10
Installing Label Stock .............................................................. 5
Label Size ................................................................................ 28, 62
Label Tear Bar .......................................................................... 3
Left Margin Offset .................................................................. 22, 61, 62
Load/Feed Button .................................................................... 3
Multiple Printers ....................................................................... 25
Offsets .................................................................................... 43, 44
Orientation .............................................................................. 37
Power LED ............................................................................... 3
Print Counter ........................................................................... 39
PrintHub ................................................................................... 14
Print Quality ............................................................................. 13, 24, 65
Printer Driver Settings ............................................................. 61
Printing ..................................................................................... 27
Sensor Type ............................................................................. 18, 60
RFID ........................................................................................ 26
Roll Specifications .................................................................... 71
Tag Specifications ..................................................................... 28
TOF Offset ................................................................................ 60
Troubleshooting ....................................................................... 60
Unload Button .......................................................................... 3
Using BarTender ....................................................................... 28, 62